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SOLIDWORKS® 2019 Quick Start

Overview of SOLIDWORKS® and the User Interface

Chapter 1

Overview of SOLIDWORKS® 2019 and the User Interface
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Below are the desired outcomes and usage competencies based on the completion of

Chapter 1.

Desired Outcomes:

Usage Competencies:

e A comprehensive
understanding of the
SOLIDWORKS® 2019 User
Interface (UI) and
CommandManager.

Ability to establish a SOLIDWORKS session.

Aptitude to utilize the following items: Menu
bar toolbar, Menu bar menu, Drop-down
menus, Context toolbars, Consolidated drop-
down toolbars, System feedback icons,
Confirmation Corner, Heads-up View toolbar,
Document Properties, and more.

Open a new and existing SOLIDWORKS part.

Knowledge to zoom, rotate and maneuver a
three button mouse in the SOLIDWORKS
Graphics window.
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Notes:
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SOLIDWORKS® 2019 Quick Start Overview of SOLIDWORKS® and the User Interface

Chapter 1 - Overview of SOLIDWORKS® 2019 and the User Interface

Chapter Objective

Provide a comprehensive understanding of the SOLIDWORKS® default User Interface
and CommandManager: Menu bar toolbar, Menu bar menu, Drop-down menu, Right-
click Pop-up menus, Context toolbars/menus, Fly-out tool button, System feedback icons,
Confirmation Corner, Heads-up View toolbar, and more.

On the completion of this chapter, you will be able to:

e Utilize the SOLIDWORKS Welcome dialog box.

e Establish a SOLIDWORKS session.

e Comprehend the SOLIDWORKS 2019 User Interface.

e Recognize the default Reference Planes in the FeatureManager.
e Open a new and existing SOLIDWORKS part.

e Utilize SOLIDWORKS Help and SOLIDWORKS Tutorials.

e Zoom, rotate and maneuver a three button mouse in the SOLIDWORKS Graphics
window.

What is SOLIDWORKS®?

e SOLIDWORKS® is a mechanical design automation software package used to build
parts, assemblies and drawings that takes advantage of the familiar Microsoft®™
Windows graphical user interface.

e SOLIDWORKS is an easy to learn design and analysis tool (SOLIDWORKS
Simulation, SOLIDWORKS Motion, SOLIDWORKS Flow Simulation,
Sustainability, etc.), which makes it possible for designers to quickly sketch 2D and
3D concepts, create 3D parts and assemblies and detail 2D drawings.

e Model dimensions in SOLIDWORKS are associative between parts, assemblies and
drawings. Reference dimensions are one-way associative from the part to the drawing
or from the part to the assembly.

e This book is written for the beginner to intermediate user.
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Overview of SOLIDWORKS® and the User Interface SOLIDWORKS® 2019 Quick Start

Start a SOLIDWORKS 2019 Session

Start a SOLIDWORKS session and familiarize yourself with the SOLIDWORKS User
Interface. As you read and perform the tasks in this chapter, you will obtain a sense of how to
use the book and the structure. Actual input commands or required actions in the chapter are
displayed in bold.

The book does not cover starting a SOLIDWORKS session in detail for the first time. A
default SOLIDWORKS installation presents you with several options. For additional
information, visit http:/www.SOLIDWORKS.com.

R

S Redeem the code on the inside cover of the book. View the provided models to
enhance the user experience.

Activity: Start a SOLIDWORKS Session.

Start a SOLIDWORKS 2019 session.
1) Type SOLIDWORKS in the Search window.

&R My stuff £ Web
2) Click All Programs.
SOLIDWORKS
3) Click the SOLIDWORKS 2019 application (or if available,
double-click the SOLIDWORKS icon on the desktop). Best match =

The SOLIDWORKS Welcome dialog box is displayed by U
SOLIDWORKS
default. e YN— L SOLIDWORKS

TR0 TOR

The Welcome dialog box provides a

convenient way to open recent documents Home  Recent MUz Alerts
(Parts, Assemblies and Drawings), view
recent folders, access SOLIDWORKS
resources, and stay updated on
SOLIDWORKS news. Recent Dciients

LENS.SLDPRT Advanced Button 16... Slot Mate 11-1.5LDA Screw Mate 11-1 SL.. Pattern Driven Com.

New

@ part @ Assembly B8 Drawing Advanced. ¥ Open

View all

4) View your options. Do not open a ) ’
document at this time. Q) 4 ,@5 ,‘ ,@
5 g g g G

5) If the Welcome dialog box is not
displayed, click the Welcome to

@ . Recent Folders View all
SOLIDWORKS icon from the = g?\}:z:\f:zzi:ai:im\s\zmsSOUDWORKS Reference .. ’ B Beta Home
Standard toolbar or click Help > = [t —— Hysolidworts et ot fses
Welcome to SOLIDWORKS fromthe | wee B “ibelafoum B Rorcrt Boalens
Maln menu. @ Arrow keys rotate the model. Ctr + Arrow Keys pan the model. Alt + Arrow Keys rotate the model clockwise and counterclockwise. < >
[ Do not show on startup
=
==l

'ﬁ Welcome to SOLIDWORKS Ctrl+F2 @
() SOLIDWORKS Help
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Home Tab

The Home tab lets you open new and existing documents, view recent documents and folders,
and access SOLIDWORKS resources (Part, Assembly, Drawing, Advanced, Open).

Recent Tab

The Recent tab lets you view a longer list of recent documents and folders. Sections in the
Recent tab include Documents and Folders.

The Documents section includes thumbnails of
documents that you have opened recently. i AL

Documents  Folders Browse.

Quick fiter: | @ | @ | B8 | ¥F| | ilter by name Remove v

Click a thumbnail to open the document, or
hover over a thumbnail to see the document ,
location and access additional information o i ~a o . . 2 | £
about the document. When you hover over a e

thumbnail, the full path and last saved date of E p > g e
the document appears. 9 ®

LENS SLDPRT Advanced Button 16... Slot Mate 11-15LDA Screw Mate 11-1 L. Pattern Driven Com.

g

‘Swept Boss 10-1.5L. ‘Swept Base 10-25L. Swept Base 10-15L Rib 8-1.5LOPRT. Rib 8-1.SLOPRT.

Learn Tab

The Learn tab lets you access instructional r—
resources to help you learn more about the
SOLIDWORKS software.

Sections in the Learn tab include:

¢ Introducing SOLIDWORKS. Opens the
Introducing SOLIDWORKS book.

Introducing SOLIDWORKS

+ SOLIDWORKS Fundamentals

samples

e Tutorials. Opens the step-by-step tutorials
in the SOLIDWORKS software. _ _

e MySolidWorks Training. Opens the N L A Ky
Training section at MySolidWorks.com.

e Introducing SOLIDWORKS (Samples).
Opens local folders containing sample
models.

@ online Tutorials & My Training R Certification # Curriculum

e Tutorials (Samples). Opens the
SOLIDWORKS Tutorials (videos) section
at solidworks.com.

e  What’s New (Samples). List of new
changes.
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SOLIDWORKS® 2019 Quick Start

e 3DContentCentral. Opens 3DContentCentral.com.

e My Training. Opens the My Training section at MySolidWorks.com.

e Certification. Opens the SOLIDWORKS Certification Program section at

solidworks.com.

e Curriculum. Opens the Curriculum section at solidworks.com.

w s

¥ When you install the software, if you do not install the Help Files or Example Files, the

Tutorials and Samples links are unavailable.

Alerts Tab

The Alerts tab keeps you updated with
SOLIDWORKS news.

Sections in the Alerts tab include Critical,
Troubleshooting, and Technical.

R

NS The Critical section does not appear if
there are no critical alerts to display.

e Troubleshooting. The Troubleshooting
section includes troubleshooting messages
and recovered documents that used to be
on the SOLIDWORKS Recovery tab in
the Task Pane.

w s

“¥" If the software has a technical problem
and an associated troubleshooting message
exists, the Welcome dialog box opens to the
Troubleshooting section automatically on
startup, even if you selected Do not show at
startup in the dialog box.

e Technical Alerts. The Technical Alerts
section opens the contents of the
SOLIDWORKS Support Bulletins RSS
feed at solidworks.com.

Close the Welcome dialog box.

6) Click Close * from the Welcome dialog
box. The SOLIDWORKS Graphics window is
displayed.

Home Recent Learn AIeE's

Technical Alerts

SOLIDWORKS 2018 SP3.0 EV (Early Visibility) is available online to run from your browser
Thu, 19 Apr 2018 16:12:43 EST
SOLIDWORKS 2018 SP3.0 EV (Early Visibility) is available for download

18 13:59:40 EST

SOLIDWORKS 2018 SP2.0 is available for download
Tue, 06 Mar 2018 16:38:21 EST

Activation System Downtime on March 3, 2018 between 5 am and 6 pm EST for Maintenance
Wed, 14 Feb 2018 08:30:15 EST
SOLIDWORKS 2018 SP1.0 is available for download

Tue, 09 Jan 2018 150338 EST

SOLIDWORKS 2017 SP5.0 is available for download
Tue, 21 Nov 2017 16:39:44 EST

Scheduled Maintenance Friday
Wed, EsT

Recent Folders

El simulation
C:\Users\Public\Documents\SOLID]
El Manuals
C\Program Files\SOLIDWORKS Co

= Final models“

@ Arrow keys rotate the model. Ctrl + Arr

%DD not show on startup

A
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View the SOLIDWORKS Graphics window.

JI%SOLIDWORKS File View Tools Help f‘ @ v@v - - e o 8 ?2-_ 0O ><

SOLIDWORKS =
Tools
Property Tab

Welcome to
\% 2 SOLIDWORKS
L)

Builder

@, SOLIDWORKS Rx

Benchmark Test

Compare My Score

Performance
=]

2
2S SOLIDWORKS' s

20 79 B \yizard

% My Products

Online Resources ~
3DEXPERIENCE
Marketplace

' Partner Solutions

Subscription
Services

& Subscription WV

If you do not see this screen, click the SOLIDWORKS Resources o | Q-8 ?-_ =X
icon on the right side of the Graphics window located in the Task

Pane. & Welcome to SOLIDWORKS

7) Hover the mouse pointer over the SOLIDWORKS icon. oo
@ Property Tab Builder

@ SOLIDWORKS Rx

m @ Performance Benchmark Test
@ Compare My Score

R Copy Settings Wizard

8) Pin * the Menu Bar toolbar.

9) View your options from the Menu bar menu: File, View, Tools, and
Help.

‘%SOLIDW%KS 4 File View Tools Help -

J D7SSOLIDWORKS File View Tools Help @ v@v - - - - é’é"}-
/
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Menu Bar toolbar

The SOLIDWORKS (UI) is designed
to make maximum use of the Graphics window. The Menu
Bar toolbar contains a set of the most frequently used tool
buttons from the Standard toolbar.

»

AD-FE-8-9N0ES

2
DS SOLIDWORKS

@ Search Knowledge Base Q' ? - — D ><|

The following default tools are available:

e  Welcome to SOLIDWORKS O Opens the Welcome dialog box, New L - Creates a
new document; Open arg8 Opens an existing document; Save & - Saves an active
document; Print =1 Prints an active document; Undo = Reverses the last action;

Select o Selects Sketch entities, components and more; Rebuild @ - Rebuilds the
active part, assembly or drawing; File Properties E= - Shows the summary information

on the active document; and Options deAg Changes system options and Add-Ins for
SOLIDWORKS.

Menu Bar menu

Click SOLIDWORKS in the Menu Bar toolbar to 975 SOLIDWORKS | Fie View Tooks Help
display the Menu Bar menu. SOLIDWORKS -
provides a context-sensitive menu
structure. The menu titles remain the 1775 SOLIDWORKS[\! Fle Edit View Insert Tools Window Help 8
same for all three types of ~ '
documents, but the menu items change depending on which type of document is active.

Example: The Insert menu includes features in part documents, mates in assembly
documents, and drawing views in drawing documents. The display of the menu is also
dependent on the workflow customization that you have selected. The default menu items for
an active document are File, Edit, View, Insert, Tools, Window, Help and Pin.

The Pin * option displays the Menu bar toolbar and the Menu bar menu as illustrated.
Throughout the book, the Menu bar menu and the Menu bar toolbar are referred to as the
Menu bar.

%SOLIDWORKS & File View Tools Help 44

‘%SOLIDWORKS[JE‘ File Edit View Insert Tools Window Help 48

JD%SOLIDWORKS File Edit View Insert Tools Window Help ﬂ @ '|21/" E' ' {é\}"
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SOLIDWORKS® 2019 Quick Start

Drop-down menu

SOLIDWORKS takes advantage of the familiar Microsoft® Windows
user interface. Communicate with SOLIDWORKS through drop-down
menus, Context sensitive toolbars, Consolidated toolbars or the
CommandManager tabs.

R

”Q: A command is an instruction that informs SOLIDWORKS to
perform a task.

To close a SOLIDWORKS drop-down menu, press the Esc key. You
can also click any other part of the SOLIDWORKS Graphics window
or click another drop-down menu.

Create a New Part Document

In the next section create a new part document.

Overview of SOLIDWORKS® and the User Interface

File Edit View Insert Tools Window Help >
Ctrl+N

Ctrl+O

Y New..
¥ Open..

Open Recent
¥ Open Drawing

[ Close Ctrl+w

58 Make Drawing from Part
49 Make Assembly from Part

& save

B savens.

@ savenn

Page Setup...
9) Print Preview...
& Print..

2P Print3D..

Ctrl+S

Ctrl+P

Z@ Publish to eDrawings

™ Pack and Go...
Send To..

& Reload..

Find References...
Properties...

Exit

Customize Menu

Activity: Create a new Part Document.

A part is a 3D model, which consists of features. What are

features?

¢ EIRIe[@FT
Y

Features are geometry building blocks.

% TRIANGLE (Default<<Default>|

Most features either add or remove material.
Some features do not affect material (Cosmetic Thread).

Features are created either from 2D or 3D sketched profiles or
from edges and faces of existing geometry.

Features are individual shapes that combined with other features
make up a part or assembly. Some features, such as bosses and
cuts, originate as sketches. Other features, such as shells and
fillets, modify a feature's geometry.

Features are displayed in the FeatureManager as illustrated
(Boss-Extrudel, Cut-Extrudel, Cut-Extrude2, Mirrorl, Cut-
Extrude3 and CirPatternl).

R

AR The first sketch of a part is called the Base Sketch. The
Base sketch is the foundation for the 3D model. The book
focuses on 2D sketches and 3D features.

N
N
N
~N

History

Sensors

Design Binder
Annotations

Solid Bodies(1)
Equations

55 Material <not specified>
Ej Front Plane

m Top Plane
ﬁj Right Plane

I_. Origin

% Boss-Extrude
C Sketch1

Cut-Extrude1
C Sketch2

Cut-Extrude2
C Sketch3

ﬁlﬂ Mirror1

Cut-Extrude3

C Sketch4

&P .
kd CirPattern1

-

-

v

v
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Overview of SOLIDWORKS® and the User Interface

There are two modes in the New
SOLIDWORKS Document dialog
box: Novice and Advanced. The
Novice option is the default option
with three templates. The
Advanced mode contains access to
additional templates and tabs that
you create in system options. Use
the Advanced mode in this book.

Create a new part.

10) Click New D from the Menu
bar. The New SOLIDWORKS
Document dialog box is
displayed.

Select the Advanced mode.

11) Click the Advanced button as
illustrated. The Advanced mode
is set.

12)
13)

Click the Templates tab.

Click Part. Part is the default
template from the New
SOLIDWORKS Document
dialog box.

Click OK from the New
SOLIDWORKS Document
dialog box.

14)

R

SOLIDWORKS® 2019 Quick Start

New SOLIDWORKS Document

Advance&

a3D arrangement of parts and/or other ~ a 2D eng

g

-

®

Assembly Drawing

ineering drawing, typically of a
sssss blies part or assembly

OK Cancel Help

New SODWORKS Document

Templates  Tutorial MBD

Part
Assembly
Drawing

Advanced mode

] =]

Preview

Novice

Cancel

Help

¥ Yllustrations may vary depending on your SOLIDWORKS version and operating system.

The Advanced mode remains selected for all new documents in the current SOLIDWORKS
session. When you exit SOLIDWORKS, the Advanced mode setting is saved.

The default SOLIDWORKS installation contains three tabs in the New SOLIDWORKS
Document dialog box: Templates, Tutorial and MBD. The Templates tab corresponds to the
default SOLIDWORKS templates. The Tutorial tab corresponds to the templates utilized in
the SOLIDWORKS Tutorials. The MBD tab corresponds to the templates utilized in the
SOLIDWORKS (Model Based Definition).
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Part1 is displayed in the FeatureManager and is the name of the document. Part1 is the default
part window name.

The Part Origin J“ is displayed in blue in the center of the Graphics window. The Origin
represents the intersection of the three default reference planes: Front Plane, Top Plane and
Right Plane. The positive X-axis is horizontal and points to the right of the Origin in the Front
view. The positive Y-axis is vertical and points upward in the Front view. The
FeatureManager contains a list of features, reference geometry, and settings utilized in the
part.

R

“¥" Edit the document units directly from the Graphics window as

MKS (meter, kilogram, second)
CGS (centimeter, gram, second)
MMGS (millimeter, gram, second)

illustrated, IPS (inch, pound, second)
I Edit Document Units. -
Editing Part Mmes . 4

/ Main Menu Toolbar

55 SoLIDWORKS | File Edit View Insert Tools Window Help x‘ 0 D-By-ﬁ-g-*}- 8 ES it @ Search Commands Q-8 ?2-_0OX

@ < |/-O-nv-# N Z =
Sketch  Smart - - - Convert - Rapid |Instant2D
omension 27 27O A Zor N
. . 40} LN . c - B
Features | Sketch | Evaluate | MBD Dimeggjons | SOLIDWORKS Add-Ins | SOLIDWORKS CAM |
\ PLEAPEEB 9o -3
I EIEA Jai SoLDwORE
T Default CommandManager
% 1 (Default< <Default>_| Heads-up VIeW Toolbar g SOLIDWORKS
History Tools
Sensors Task Pane @ Property Tab Builder
» P besian Bi
E Design Binder Part FeatureManager @ SOLIDWORKS Rx
4 Annotations = Performance
Eoations = Benchmark Test
G Compare My Score
878 Material <not specified>
. Copy Settings
[fj Front Plane L B \yord
[g Top Plane T My Products
[ﬂ Right Plane
I_, Origin . Online Resources  ~
Hide/Show 3DEXPERIENCE
FeatureManager tab Origin A
® Partner Solutions
Subscription R
. Services
Triad Subscription
)¢ / @ ernvices
Zi‘x
< > | *Trimetric
| el | 3D Vieys | Motion sn?1 [
soLIDWORKremium 201 Editing Part fcs o ﬁ
Model Mode 3D Views Motion Mode Units Tags
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Overview of SOLIDWORKS® and the User Interface

View the Default Sketch Planes.

15)
16)
17)
18)

Click the Front Plane from the FeatureManager.
Click the Top Plane from the FeatureManager.

Click the Right Plane from the FeatureManager.

SOLIDWORKS® 2019 Quick Start

Click the Origin from the FeatureManager. The Origin is the intersection of the Front, Top, and

Right Planes.

E & &

Section Sensor Performance
Properties Evaluation

|
T ©0 &
Design |nterference Measure Markup
Study  Detection View

JM File Edit View Insert Tools Window Help % | 7 -@vvv“’)v .8 ?2-_0OX

Zebra Stripes
@ Import Diagnostics Curvature

------- T
ﬂ Top Plane

[Ej Right Plane

I_, Origin

< >

Y

P

*Trimetric

Features ‘ Sketch ‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ g0 _ &5 X
- PPEAPEE ©-o S@-2-
Y
D) A
7 ] @]
% Part1 (Default<<Default>_D FrO nt Pl @
History Q N e B
Sensors
» Em Design Binder { D e
4 Annotations E=
Equations i =]
§5 Material <not specified>
©

R Model ‘ 3D Views ‘ Motion Study 1 ‘

Redeem the access code on the inside cover of the book. Download the SOLIDWORKS
2019 folder to your hard drive. Open the Bracket part. Review the features and sketches in
the Bracket FeatureManager.

Activity: Download the SOLIDWORKS folder. Open the Bracket Part.

Download the SOLIDWORKS folder. Open an existing SOLIDWORKS part.

ADE-2- [0k

pen (Ctrl+0)

19)

20)
21)
22)

Download the SOLIDWORKS 2019 folder.

Click Open i from the Menu bar menu.
Browse to the SOLIDWORKS 2019\Bracket folder.

Double-click the Bracket part. The Bracket part is displayed
in the Graphics window.

PAGE 1-12
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J‘%soupwom‘ File Edit View Insert Tools Window Help | O E-S- -u BEs 3 2-_0OX
J° swept Boss/Base ) ® B sweptcet B EE Arb g8 wrap ‘a Y

Extruded Revolved i Lofted Boss/Base  Extruded Hole Revolved m Lofted Cut ~ Fillet Linear E Draft @ Intersect | Reference Curves

Boss/Base Boss/Base cut  Wizard  cut Pattern Geometry
1 7825¢ ) Boundary Boss/Base . @ Boundarycut . . (W shell B Mirror . .

Features Sketch‘ Evaluate‘ MBD Dimensions‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ 00 _=FX

PLENRE © © SR-T-

FeatureManager
design tree

% Bracket (Default<<Default>_[ ~
» History
Sensors
4 Design Binder
Annotations
Solid Bodies(1)
Equations 1
858 Material <not specified>
m Front Plane
[g Top Plane
g Right Plane
I_, Origin

@ Extrude-Thin1

E Fillet1
» [ @5.0 (5) Diameter Hole1 ;
9

|1 ",
< > *Isometric

EIEETH model | 3D Views | Motion Study 1

The FeatureManager design tree is located on the left side of the SOLIDWORKS Graphics
window. The FeatureManager provides a summarized view of the active part, assembly, or
drawing document. The tree displays the details on how the part, assembly or drawing
document was created.

Use the FeatureManager rollback bar to temporarily roll back to an earlier state, to absorbed
features, roll forward, roll to previous, or roll to the end of the FeatureManager design tree.
You can add new features or edit existing features while the model is in the rolled-back state.
You can save models with the rollback bar placed anywhere.

In the next section, review the features in the Bracket FeatureManager using the Rollback bar.

Activity: Use the FeatureManager Rollback Bar option.

Apply the FeatureManager Rollback Bar. Revert to an earlier state in the model.

23) Place the mouse pointer over the rollback bar in the
FeatureManager design tree as illustrated. The pointer changes to a

hand @l-. Note the provided

information on the feature. This is » &) Extrude-Thin1 ' gwu‘jﬂh'm

called Dynamic Reference ® Fillett X @F'"m _ |

Visualization. v [& 25.0 (5) Diameter Hole1 e fpii::?'amew rolet
24) Drag the rollback bar up the L Lpattert o, , %m_o (10) Diameter Hole1

FeatureManager design tree until it is b1 R e el BE | pattern2

above the features you want rolled EE LPattem? v 8 cut-Extrudet

back, in this case 10.0 (10) Diameter » (@ Cut-Extrude1 FE | pattern3

Hole1. EE LPattern3 H 6\_‘

25) Release the mouse button.
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SOLIDWORKS® 2019 Quick Start

View the first feature in the Bracket Part.

26) Drag the rollback bar up the FeatureManager above Fillet1. View the results in the Graphics

window.

Return to the original Bracket Part

FeatureManager.

27) Right-click Extrude-Thin1 in the
FeatureManager. The Pop-up
Context toolbar is displayed.

Click Roll to End. View the
results in the Graphics window.

28)

J,)’SSOLIDWORKS‘ File Edit View Insert Tools Window Help f‘ o0 ~@vﬁvgvr)- 8 .8 ?2-_0OX
ﬁ 3 f Swept Boss/Base @ @ ﬁ Swept Cut @ EE @ Rib Wrap .ﬂ: U

Extruded Revolved i Lofted Boss/Base Extruded Hole Revolved @ Lofted Cut Fillet Linear B Draft @ Intersect Reference Curves |

B B B B cut Wizard  cyt Pattern eometry
D=s/Ba:SjEees Base @ Boundary Boss/Base Y - . @ Boundary Cut | . - @ Shell FF‘] Mirror o <
Features ‘ Sketch ‘ Evaluate| MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ OO0 &3 X

. PLAPEE ©-© @@ =-
$ BElRe[@F

7

» Em Design Binder "
4 mAnnotations

Solid Bodies(1)

@ Equations

55 Material <not specified>

Ej Front Plane

Ej Top Plane %
Ej Right Plane

I_, Origin

@Extrude-Thim -~

] Fillet1 bl

gEk|

v

g2

° f®

-

» (B @5.0 (5) Diameter Hole1
EE LPattern1

» (& 310.0 (10) Diameter Hole’
EE LPattern2

Y

A

*Isometric

< o >
! Model | 3D Views | Motion Study 1 |

v

M=l ~ .

?%@@1'41

x .
4 Desigrtmm{:)‘&é:
» [A] Annot Feature (Extrude-Thin1)

» Solid E Roll to Previous
Equati‘ Roll tcL}End
Ei Mater Comment
Ej Eront Parent/Child...

Configure Feature

Ijij Top Pl

N [ Right

Origin
> §) Extrud

Delete...
Add to Favorites

Save Selection

& & X
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Heads-up View toolbar AP S T 0R D
SOLIDWORKS provides the user with T

numerous view options. One of the most P RREE © - ®- =
useful tools is the Heads-up View toolbar displayed PLENLE-© &

in the Graphics window when a document is active.

N5 Dynamic Annotation Views 2 . Only available with SOLIDWORKS MBD (Model Based
Definition). Provides the ability to control how annotations are displayed when you rotate

models.

In the next section, apply the following tools: Zoom to Fit, Zoom to Area, Zoom out, Rotate
and select various view orientations from the Heads-up View toolbar.

Activity: Utilize the Heads-up View toolbar.

Zoom to Fit the model in the Graphics window.

29) Click the Zoom to Fit o icon. The tool fits the model to the
Graphics window. \

Zoom to Area on the model in the Graphics window.

30) Click the Zoom to Area ‘D‘ icon. The Zoom to Area GD“ icon
is displayed.

Zoom in on the top left hole.

31) Window-select the top left corner as illustrated. View the
results.

De-select the Zoom to Area tool.

32) Click the Zoom to Area D icon.

Fit the model to the Graphics window.

33) Pressthe fkey.

Rotate the model. 25 soupworks| Fie it view nsert Toos widow tep ¢ | £ ()P~ 20k - 8 Es 8 2- - O
. & 9 I swepttosmue B B @ Bsencw B 5 Jrb EBwe ‘e U
34) Hold the middle mouse button down. Drag  [ex frpey B e G o s
SoundarySosBase . SoundayCut e (B shel BONor |
Features | Sketch | Evaluate | MBD Dimensions | SOLIDWORKS Add-Ins | SOLIDWORKS CAM | 00 -5 X
upward U, downward U, to the left U C— FLENGAE ©-9-@R T
%(;7 BloI@[F"™
and to the right U to rotate the model in the € sk otatc oo 1~
Graphics window. o
» [[3]Design Bi
» [@)solid Bodies(1)
[ €quations
$25 Materal <not specifeds
() Front Plane
[J Top Plane
[ Right Plane
1., orgin

» @) Bxtrude-Thin y
B Fillet1

» (3 @5.0 (5) Diameter Hole1 z
[Fare o

< >
SIS Model | 3D Views | Motion Study 1 |
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Display a few Standard Views.

35) Click inside the Graphics window.

36) Click Front @ from the drop-down Heads-up
view toolbar. The model is displayed in the

Front view.

37) Click Right [ from the drop-down Heads-up
view toolbar. The model is displayed in the

Right view.

38) Click Top \» from the drop-down Heads-up
view toolbar. The model is displayed in the Top

view.

Display a Trimetric view of the Bracket model.

39) Click Trimetric @ from the drop-down Heads-
up view toolbar as illustrated. Note your options.
View the results in the Graphics window.

SOLIDWORKS Help

Help in SOLIDWORKS is
context-sensitive and in
HTML format. Help is
accessed in many ways,
including Help buttons in all
dialog boxes and
PropertyManager (or press
F1) and Help @ tool on the
Standard toolbar for
SOLIDWORKS Help.

SOLIDWORKS® 2019 Quick Start

v B
-

PIEPR

ﬁ Dimetric
>

Trimetric

Jp’Sso‘_mwom(s‘ File Edit View Insert Tools Window Help | 0 D'@"E'n' B E:s & ?2-_OX

Extruded Revolved b Lofted Boss/Bas
Boss/Base Boss/Bas

Q S J° Swept Boss/Base

@ Boundary Boss/Base

e

B @ Bswertce @ EE Jro Egwep ‘@

Bxtruded Hole Revolved (Jl Lofted Cut  Filet Linear [ praft (N Intersect | Reference Curves

Cut Wizard  cug
Y B “ @ Boundarycut |

Pattern Geometry

. [ shell BH) Mirror

Features | Sketch | Evaluate | MBD Dimensions | SOLIDWORKS Add-Ins | SOLIDWORKS CAM

a0 _2X

S IEIRISISIET 6@ Fm

@& Bracket (Default<<Default>_[ A
» [@]History

Sensors

Design Binder

m Annotations

Solid Bodies(1)

EE Equations ﬂ
855 Material <not specified>
E] Front Plane

() Top Plane

L)J Right Plane

1, origin

@ Extrude-Thin1

B Fillett

[ 25.0 (5) Diameter Hole1
L IC R N,

Y

A

*Isometric

< >
\L_Model 3D Views | Motion Study 1

FFT TN RN Y N=R

i)
o
[,
e
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40) Click Help from the Menu bar. vee] #| Y0P -
41) Click SOLIDWORKS Help. The SOLIDWORKS Help Home \%&Wemmeto SOLIDWORKS
N

Page is displayed by default. View your options. SOLIDWORKS Help

L ™A SOLIDWORKS Tutorials
“¥* SOLIDWORKS Web Help is active by default under SOUDUBRIE E
Help in the Main menu. API H:'P
Searc
Close Help. Return to the SOLIDWORKS Graphics window. :j:leifeNNOtes
42) Close (X | SOLIDWORKS Home. @ Introducing SOLIDWORKS (pdf)
Moving from 2D to 3D
SOLIDWORKS Tutorials
Display and explore the SOLIDWORKS tutorials. Check for Updates...
43) Click Help from the Menu bar. Activate Licenses..
44) Click SOLIDWORKS Tutorials. The SOLIDWORKS Tutorials Deactivate Licenses..
are displayed. The SOLIDWORKS Tutorials are presented by Show Licenses..
category. My Products...
45) Click the Getting Started category. The Getting Started About SOLIDWORKS..
category provides lessons on parts, assemblies, and drawings. Customize Menu

In the next section, close all models, tutorials and view the
additional User Interface tools.

Activity: Close all Tutorials and Models.

Close SOLIDWORKS Tutorials and models.
46) Close Ed SOLIDWORKS Tutorials.
47) Click Window, Close All from the Menu bar menu.

Window  Help x‘ o) -@v

Viewport

= New Window

[T Y

Cascade
Y E Tile Horizontally

| D] Tile Vertically

~L Arrange Icons
R Close All

User Interface Tools

The book utilizes additional areas of the SOLIDWORKS
User Interface. Explore an overview of these tools in the
next section.

1 Part1 *

2 Bracket.SLDPRT

Browse Open Documents...

Customize Menu
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SOLIDWORKS® 2019 Quick Start

Right-click s o G

Right-click in the Graphics window on a Zoom to Fit
model, or in the FeatureManager on a feature |~

Zoom to Area

or sketch to display the Context-sensitive ¥ zoom LS

toolbar. If you are in the middle of a (& rem e
1 : : Q% Pan

command, this toolbar displays a list of C ol view

options specifically related to that command.

Rotate About Scene Floor

Set Current View As...

Right-click an empty space in the Graphics
window of a part or assembly, and a
selection context toolbar above the shortcut
menu is displayed. This provides easy access
to the most commonly used selection tools.

View Orientation...

Edit Scene

B

@

Open Drawing
Recent Commands
Contour Select Tool

Customize Menu

SR« @
FC2PLBP

Consolidated toolbar

Similar commands are grouped together in the CommandManager.
For example, variations of the Rectangle sketch tool are grouped in
a single fly-out button as illustrated.

If you select the Consolidated toolbar button without expanding:

For some commands such as Sketch, the most commonly used
command is performed. This command is the first listed and the
command shown on the button.

For commands such as rectangle, where you may want to
repeatedly create the same variant of the rectangle, the last used
command is performed. This is the highlighted command when the
Consolidated toolbar is expanded.

System feedback icon

Select Tangency
% Save Selection
Zoom/Pan/Rotate
Recent Commands
Face
o0 Change Transparency
G Create Plane Parallel to Screen
Feature (Extrude-Thin1)
Comment
Parent/Child...
Configure Feature

Delete...

]

Add to Favorites

% Save Selection
Body

Isolate

Export to DXF / DWG

FeatureWorks...

/-O-1-#
ORe-0-A

[ (I/Z\grner Rectangle

=1 Center Rectangle

Q 3 Point Corner Rectangle
@: 3 Point Center Rectangle
[ Parallelogram

SOLIDWORKS provides system feedback by attaching a
symbol to the mouse pointer cursor. [}

by | [Re

k. ]

The system feedback symbol indicates what you are

Face - Edge'Dimension- - Vertexq|

selecting or what the system is expecting you to select.

As you move the mouse pointer across your model, system
feedback is displayed in the form of a
symbol, riding next to the cursor as
illustrated. This is a valuable feature in
SOLIDWORKS.
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Confirmation Corner q O

When numerous SOLIDWORKS commands are active, a symbol or a
set of symbols is displayed in the upper right-hand corner of the Graphics C@
window. This area is called the Confirmation Corner. L

When a sketch is active, the confirmation corner box displays two
symbols. The first symbol is the sketch tool icon. The second symbolisa |1 [ - &
large red X. These two symbols supply a visual reminder that you are in an

active sketch. Click the sketch symbol icon to exit the sketch and to save VL\\S
any changes that you made.

When other commands are active, the confirmation corner box provides a
green check mark and a large red X. Use the green check mark to execute
the current command. Use the large red X to cancel the command. s

w s

“¥" Confirm changes you make in sketches and tools by using the D

keyboard shortcut to move the OK and Cancel buttons to the pointer %
location in the Graphics window. Q’

Heads-up View toolbar

SOLIDWORKS provides the user with numerous view options from the
Standard Views, View and Heads-up
View toolbar.

Standard Views
The Heads-up View toolbar is a t - p
transparent toolbar that is displayed L AL o - i
in the Graphics window when a View
document is active. @‘ iR -§ @ -@2m -

You can hide, move or modify the ————————— _ :
Heads-up View toolbar. To modify FEP O T TR -9-®- @ @ -E3-

the Heads-up View toolbar, right-

click on a tool and select or deselect PE) ﬂ a@ @2 @ @ - ®- QP
the tools that you want to display. “\

The following views are available.
Note: available views are document
dependent.

For a drawing document

e Zoom to Fit e : Zooms the model to fit the Graphics window.

£ . .
e Zoomto Area ¢ : Zooms to the areas you select with a bounding box.

e  Previous View <& : Displays the previous view.

PAGE 1-19
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o Section View e : Displays a cutaway of a part or
assembly, using one or more cross section planes.

PEAPEK

i-v-e-ea o

4

e  Dynamic Annotation Views %{ Only available View Selector (Ctrl+SpaceBar) 8

Show or hide the in-context View

with SOLIDWORKS MBD. Provides the ability Selector to choose from a variety of

to control how annotations are displayed when standard and non-standard view >
orientations. Press Alt to expose only
you rotate models. the back faces of the View Selector.

The Orientation dialog has an option to display a view

cube (in-context View Selector) with a live model preview. This
helps the user to understand how each standard view orientates
the model. With the view cube, you can access additional
standard views. The views are easy to understand and they can be
accessed simply by selecting a face on the cube.

To activate the Orientation dialog box, press (Ctrl + spacebar) or

click the View Orientation ©  icon from the Heads up View
toolbar. The active model is displayed in the View Selector in an
Isometric orientation (default view).

Click the View Selector icon in the Orientation dialog box to
show or hide the in-context View Selector.

w s

-~

Vs Press Ctrl + spacebar to activate the View Selector.

R

" Press the spacebar to activate the Orientation dialog

box. P AP A ¢ 0% o

e  View Orientation box (2~ : Provides the ability to
select a view orientation or the number of viewports.
The available options are Top, Left, Front, Right,
Back, Bottom, Single view, Two view - Horizontal,
Two view - Vertical, Four view. Click the drop-down

ve
= -
TGN
b=
m[=fnl==

arrow to access Axonometric views: Isometric,
Dimetric and Trimetric.

o Display Style ¥ - Provides the ability to display the
style for the active view. The available options are
Wireframe, Hidden Lines Visible, Hidden Lines
Removed, Shaded, Shaded With Edges.

PAGE 1-20
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SOLIDWORKS® 2019 Quick Start Overview of SOLIDWORKS® and the User Interface

e Hide/Show Items ® ~: Provides the ability to select items to hide or show in  |® @ & -
the Graphics window. The available items are document dependent. Note the ?' \%
View Center of Mass ¥ icon. M‘

o Edit Appearance @: Provides the ability to edit the appearance of entities of |1
the model. e

D 52

o Apply Scene & " Provides the ability to apply a L
scene to an active part or assembly document. =B gﬂzg %"
View the available options. Y A — B

. R . o @ shadows In Shaded Mode =

o View Setting : Provides the ability to select @ Ambient Occusion =
the following settings: RealView Graphics, R Perspective Se
Shadows In Shaded Mode, Ambient Occlusion, @® coroon B o
Perspective and Cartoon.

e Rotate view C : Provides the ability to rotate a
drawing view. Input Drawing view angle and
select the ability to update and rotate center marks
with view. &~ pil ige C g ®- @

e 3D Drawing View &) : Provides the ability to
dynamically manipulate the drawing view in 3D ¥ @
to make a selection. Options

Changes options settings for

To display a grid for a part, click Options i , SOLIDWORKS.

Document Properties tab. Click Grid/Snaps, check —

the Display grid box. \\‘E Disolay grid

e Dash
“¥" Add a custom view to the Heads-up View [V automatic scaling
toolbar. Press the space key. The Orientation dialog Major grid spacing: 100.00mm |2
o

box is displayed. Click the New View @9 tool. The Minor-lines per major: 4 2

Name View dialog box is displayed. Enter a new _

named view. Click OK. Snap points per minor: | 1 =

Use commands to display information about the triad

o . . . Go To System Snaps
or to change the position and orientation of the triad.

Available commands depend on the triad's context.

Y
Triad
\
K
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ol
é@} bgptions
Customize...

Add-Ins...

SOLIDWORKS CommandManager

The SOLIDWORKS CommandManager is a Context-sensitive
toolbar. By default, it has toolbars embedded in it based on your
active document type. When you click a tab below the
CommandManager, it updates to display that toolbar. For example,
if you click the Sketch tab, the Sketch toolbar is displayed.

w s

2% For commercial users, SOLIDWORKS Model Based
Definition (MBD) and SOLIDWORKS CAM is a separate
application. For education users, SOLIDWORKS MBD and
SOLIDWORKS CAM is included in the SOLIDWORKS Education Edition.

Save/Restore Settings...

Button Size

Below is an illustrated CommandManager for a Part document. Your tabs may vary
depending on your SOLIDWORKS applications.

JDZ‘SOLIDWORKS‘ File Edit View Insert Tools Window Help f‘ ﬁ '@" g'r)' é@}" Part
3 f Swept Boss/Base @ @ ﬁ Swept Cut @ EE @ Rib Wrap Oﬁ U Ff\m
Extruded Revolved i Lofted Boss/Base Extruded I-!ole Revolved m Lofted Cut Fillet Linear i} Draft [@ Intersect Reference Curves fjngtant3D
Boss/Base Boss/Base cut Wizard ¢ Pattern . Geometry
@ Boundary Boss/Base - @ Boundary Cut | - @ Shell i‘tﬂ Mirror - -
Features | Sketch | Evaluate | MBD Dimensions | SOLIDWORKS Add-Ins | SOLIDWORKS CAM SURPEE-©-©-&
f N .
Q <\ / - @ - [U - % @ @ [.E'itﬂ Mirror Entities J_® @ z @
Exit Smart . N - @ - A Trim  Convert Offset EE Linear Sketch Pattern  ~ Display/Delete pepair Rapid |Instant2D
Sketch| Dimension Entities Entities Entities Relations  Sketch Sketch
- “® el - - - -
Features | Sketch | Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins | SOLIDWORKS CAM | PLOREO K-
D?,i; g o o F @ B @ Check & Deviation Analysis [ Draft Anal 3 @
esign Interference Measure Markup ~ Mass  Section Sensor Performance ([7) Geometry Analysis SimulationXpress  FloXpress DFMXpress  DriveWorksXpres|
Study  Detection View Properties Properties Evaluation Analysis Wizard  Analysis Wizard Analysis Wizard Wizard
Features | Sketch Evaluate MBD Dimensions = SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM o0 _ 32X E.:g
- -
N =) U
Auto Dimension Location Size Bas_ic Locration Pattern Datum Geometric
Scheme Dimension Dimension Dimension  Featyre Tolerance
Features ‘ Sketch ‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘
[T A
L @ @ o & E % T kL &
3DEXPERIENCE CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst SOLIDWORKS
Marketplace 360 Motion Routing Simulation Toolbox Flow Simulation
Features ‘ Sketch ‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ LCLOREERE -
0 &
RS . . .
Set button size from the Toolbars tab of the Customize dialog 5 Sptions
box. To facilitate element selection on touch interfaces such as e
tablets, you can set up the larger Size buttons and text from the e

Options menu (Standard toolbar).
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Overview of SOLIDWORKS® and the User Interface

The SOLIDWORKS CommandManager is a Context-sensitive

g N

toolbar that automatically updates based on the toolbar you want to
access. By default, it has toolbars embedded in it based on your
active document type.

w s

W For commercial users, SOLIDWORKS Model Based

{{3} bgptions

Customize...
Add-Ins...
Save/Restore Settings...

Button Size

Definition (MBD) and SOLIDWORKS CAM is a separate
application. For education users, SOLIDWORKS MBD and
SOLIDWORKS CAM is included in the SOLIDWORKS Education
Edition.

Below is an illustrated CommandManager for a Drawing document.
Your tabs may vary depending on your SOLIDWORKS
applications.

Iy I R A &

0= O e 4 Q@ KN I=
Standard Model Projected Auxiliary Section Detail Broken-out Break Crop  Alternate
3 View View  View View View View | Section View View Position View

View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format

v/ Surface Finish EB3 Geometric Tolerance € Center Mark
Blocks £ Centerline
Area HatchyFill

g AAA
<\ <‘\\ ks i A oM D Balloon
Smart  Model ~Spell Format Note Linear Note () auto Balloon /%< Weld Symbol Datum Feature
Pattern

Dimension jtems Checker Painter al e
0 Magnetic Line LI® Hole Callout  §a Datum Target

£73 Revision Cloud ~ Tables

28

View Layout | Annotation | Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format ;

N =

& SOV K

@ D’H] Mirror Entities JQ

smant |- S - ()~ 1 Offset EE Linear Sketch Pattem  + Display/Delete
i i A FF .
Dimension Entities Relations

B} . @ —\ . . B Entities . B .

View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format ’:

Y B F b b % =

Spell  Measure Section Performance Compare Check Active DriveWorksXpress
Checker Properties Evaluation Documents Document Wizard

View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format

® @ % & E % ¥ [ <

CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst SOLIDWORKS

360 Motion Routing Simulation Toolbox Flow Simulation
View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins | Sheet Format — =
Edit Sheet| Title Block Automatic
Format Fields Border
View Layout ‘ Annotation ‘ Sketch ‘ Evaluate | SOLIDWORKS Add-Ins ‘ Sheet Format :
S (V] View Layout
w 1w ¥ | Annotation
_/Q‘: . . . v | Sketch
To add a custom tab, right-click on a tab and click .
Customize CommandManager. You can also select to add a blank BB <oLiowORKS Add-ns
tab and populate it with custom tools from the Customize dialog | %] sheet Format
bOX. | ¥ | Use Large Buttons with Text
\‘ Customize CommandManager...
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The SOLIDWORKS CommandManager is a Context-sensitive
toolbar that automatically updates based on the toolbar you want to

access. By default, it has toolbars embedded in it based on your
active document type.

w s

> For commercial users, SOLIDWORKS Model Based
Definition (MBD) is a separate application. For education users,

SOLIDWORKS MBD is included in the SOLIDWORKS Education
Edition.

Below is an illustrated CommandManager for an Assembly

SOLIDWORKS® 2019 Quick Start

oL
é@} %Aptions
Customize...

Add-Ins...

Save/Restore Settings...

Button Size

document. Your tabs may vary depending on your SOLIDWORKS applications.

BE o ) _
Lﬁ@ [FI7] @ ﬂ ] % " h\i @ @
Insert  Mate Linear Component  gmart Move Assembly Reference New Motion  Bill of | Exploded jngtant3D| Update = Take Large Assembly
Components Pattern Fasteners Component Features Geometry  siudy  Materials  View Speedpak Snapshot  Mode
Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-Ins | M8D | PPAPRE © - ©- L -T-
g <& /7 0-v- ¥ U L [H] Mirror Enities lo A7 Make Block =
Create Smart [ - Y- (D) - A Tim Convert Offset B Linear Sketch Pattern  ~ Display/Delete Repair (43 save Sketch (=18
layout Dimension — Entities Entities Epities Relations  syetch - Components
@-O - - . (8, msert Block .
Assembly | Layout \ Sketch | Evaluate \ SOLIDWORKS Add-Ins | MED | LPOEPERP §© - & @3-
I . g
Q <\ / MORIVE % \§ [Fe] Mirror Entities P Ell =
Exit Smart - 0 @ Trim  Convert Offset EE Linear Sketch Pattern  ~ Dlsplay/_DeIete Repair Rapid (Instant2D
Sketch Dlmensn:m @ _w Entities Entities Epgities Relations  syetch Sketch
- - = -
Assembly | Layout‘ Sketch | Evaluate | SOLIDWORKS Add-Ins | MBD PR
L = Eﬂ @ 74 ‘r" g & @ & o & o t & -] /=] (2]
Design |nterference Clearance Measure Markup ~ Mass ~ Section Sensor Assembly Performance Curvature Symmetry Compare Check Active FloXpress  Dr
Study  Detection Verification Allgnmem View Propemes Properties Visualization ~Evaluation Check  Documents Document t Analysis Wizard Analysis Wizard Wizard Costing
Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-ins | MBD | PEEPZER-©-2- SR-T-
® =
@ ® () ) <
3DEXPERIENCE CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst SOLIDWORKS
Marketplace 360 Motion Routing Simulation Toolbox Flow Simulation
Assembly ‘ Layout‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ MBD‘ PO @E KRE-P-®- ﬁ
A4 DY ~A P P o B A @@ M e & 2 i£]
Auto Dimension ~Location Import Datum Surface Weld Note Balloon Stacked ~Smart  Bill of Tables Capture Section Model Exploded  Dynamic 3DPDF  Publishto
Scheme Scheme Target Finish Symbol Balloons Dimension Materials 3DView View Break View View Annotation Views Template Editor 3D POF
Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-ins | MBD DRORE O - SP--

By default, the illustrated options are selected in the Customize box
for the CommandManager. Right-click on an existing tab and click
Customize CommandManager to view your options.

w s

" You can set the number of mouse gestures to 2, 3, 4, 6, 8, or
12 gestures. If you set the number to 2 gestures, you can orient
them vertically or horizontally.

nnnnnnnnn

ccccc

Print Gesture Guides.

Resetto Defauts

PAGE 1-24



SOLIDWORKS® 2019 Quick Start

Float the CommandManager. Drag the Features, Sketch or any
CommandManager tab. Drag the CommandManager anywhere on
or outside the SOLIDWORKS window.

To dock the CommandManager, perform one of the following:

While dragging the CommandManager in the SOLIDWORKS
window, move the pointer over a docking icon -

Dock abave Dockleft Dockright and click the needed

command.

Double-click the floating CommandManager to revert the
CommandManager to the last docking position.

Screen shots in the book were made using SOLIDWORKS 2019
SPO running Windows® 10.

Selection Enhancements

Right-click an empty space in the Graphics window of a part or
assembly; a selection context toolbar above the shortcut menu
provides easy access to the most commonly used selection tools.

e Box Selection :--. Provides the ability to select entities in parts,
assemblies, and drawings by dragging a selection box with the
pointer.

e Lasso Selection <. Provides the ability to select entities by
drawing a lasso around the entities.

e Selection Filters ?}'. Displays a list of selection filter
commands.

o Select Other . Displays the Select Other dialog box.
o Select . Displays a list of selection commands.

e Magnified Selection Q. Displays the magnifying glass, which
gives you a magnified view of a section of a model.
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CommandManager

@ Extruded Boss/Base
§ Revolved Boss/Base
f Swept Boss/Base
i Lofted Boss/Base
@ Boundary Boss/Base
Extruded Cut

@ Hole Wizard

@ Revolved Cut

ﬁ Swept Cut

m Lofted Cut

@ Boundary Cut

B Fillet

EE Linear Pattern

4 Rib

E Draft

(W shell

Wrap

@ Intersect

i"tﬂ Mirror

eiii Reference Geometry

U Curves

‘D\u Instant3D

SOLIDWORKS CAM ~ SOLIDWORKS Add-Ins  MBD Dimensions |Evaluate [Sketch |Features [

—

hs e #ING

Zoom to Fit
Zoom to Area
Zoom In/Out
Rotate View
Pan

Roll View

QLA

Set Current View As...
View Orientation...

Edit Scene

<

Open Drawing
Recent Commands

Contour Select Tool

Customize Menu

Rotate About Scene Floor

»
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w s

CommandManager and un-check the Use Large Buttons with

Text box. This eliminates the text associated with the
w1

AR DimXpert provides the ability to graphically che

¥ Save space in the CommandManager, right-click in the %

SOLIDWORKS® 2019 Quick Start

tool.

CommandManager
¥ | Use Large Buttons with Text
Customize...

2D 2D to 3D

ck if the £ 3owox

model is fully dimensioned and toleranced. DimXpert E~ Align
automatically recognizes manufacturing features. Manufacturing
features are not SOLIDWORKS features. Manufacturing features

are defined in 1.1.12 of the ASME Y14.5M-1994
Dimensioning and Tolerancing standard. See

SOLIDWORKS Help for additional information. G ER ¢ @F
¢
- racke efault<<Default>_[ »
FeatureManager Design Tree ‘%Hi:&f:/ E—
. . . Sensors
The FeatureManager consists of various tabs: + [T Design Binder
@a » [A] Annotations
o FeatureManager design tree ~ tab. » i) Solid Bodies(1)
= Equations
L4 P}’Opel’lyManager tab §5 Material <not specified>
ﬂ Front Plane
o ConfigurationManager [ tab. gTC’P Plane &
Right Plane
e DimXpertManager @ tab. L, origin ‘H.QEF e
- @Extrude.Thim Ide reaturelVianager Iree Area
e DisplayManager @ tab. ® g;“e““
- + [B @50 (5) Diameter Hole1
o CAM FeatureManager tree S 1> tab. @C cretehs '
Sketch2
:"ﬂ EE &tterm
Click the direction arrows to expand or ~ ([@2100 (10) Diameter Hole-
collapse the FeatureManager design tree. %zt::z:j Y
Tabs will vary depending on your % Lpa“er”zd ZJ\K
. . > Cut-Extrude1 hd
SOLIDWORKS applications and Add-
ins.
) E | Blo[@F
Select the Hide/Show FeatureManager $ Rklo@ ~ Sensor @
;[g . &) @ FLATBAR-DesignTable (Def|| |~ * ™
Areatab | [ as illustrated to enlarge the ~ History Sensor Type ~
Graphics window for modeling. Sensors R v
s , Des Add-Sensor... E"Pe’:es . ~
X The Sensors tool (2 located in the » [A)ann  Notfiations. |
FeatureManager monitors selected > [@]soli Rename tree item
properties in a part or assembly and alerts e
you when values deviate from the VDa'“e oonaesizb
specified limits. There are five sensor types: e

Simulation Data, Mass properties, Dimensions, Measurement and

Costing Data.
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Various commands provide the
ability to control what is displayed " Dl o o i cmponc
. . Drawings it name with slow double clic
in the FeatureManager design tree. oy ste e e
Performance
. Colors
1. Show or Hide FeatureManager s s e ems
: D:E‘\:lluns/snapi [i=Blocks Automatic v [EJequations S e
1tems. seecton o
oerformance [pesign Binder Show v S Material Show v
\IIQ/ és:r'::h::ferences [AJAnnotations Show N i Default Planes Show v
- - . . Default Templates
“¥* Click Options & from the (ot v puenate - Lyomon —
Menu bar. Click FeatureManager |~ "X e s Ao Y| [ eferncs huonatc
from the System Options tab. o toobos (S puorsie oo
1 File Explorer ites utomatic ~ A ENSors oW =
Customize your FeatureManager bt e * s !
from the Hide/Show tree Items e O e ’
. Export [iselection Sets Automatic v [@)Graphic Bodies Automatic
dialog box.
g [EMarkups Automatic v
2. Filter the FeatureManager design -

tree. Enter information in the filter

field. You can filter by Type of SO ER S @R
features, Feature names, Sketches, Folders, Mates, User- T eeteh X
de](l‘ned tags and Custom properties. @5 Bracket (Default<<Default>_Dis|
v @Extrude-Thim
- | - C Sketch1
“¥" Tags are keywords you can add to a « [ 5.0 (5) Diameter Holet
SOLIDWORKS document to make them easier to filter [ Sketch3
and to search. The Tags & icon is located in the bottom L sketch2
right corner of the Graphics window. ~ (82100 (10) Diameter Hole
C Sketch5
- ] - C Sketch4
‘¥ Collapse all items in the FeatureManager, right- - [@ cut-Bxtrudet
click and select Collapse items, or press the Shift + C ([ sketché
keys. = o
The FeatureManager design tree and the Graphics g Blo[@

window are dynamically linked. Select sketches, @ @ FLATBAR-DesignTable ([ ~

features, drawing views, and construction geometry in History
either panc. Sensors

4 Design Binder

Split the FeatureManager design tree and either display » P Anmotations

two FeatureManager instances, or combine the » Pl Solid Bodies(1)
FeatureManager design tree with the Split Equations
ConfigurationManager or PropertyManager. Sl 36061 Alloy .

< >

Move between the FeatureManager design tree,

PropertyManager, ConfigurationManager, I@ @ Fr
DimXpertManager, DisplayManager and others by cj%
onfigurationivianagg

selecting the tab at the top of the menu.

~ @ /@ FLATBAR-DesignTable C

Note: Tabs will vary depending on your SOLIDWORKS [ Tables

applications and Add-ins. [ o Default [ GIDS-SC-1i
[%» 3HOLE [ GIDS-SC-1C

[}. 5HOLE [ GIDS-SC-1(|
[%' 7HOLE [ GIDS-SC-1(
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The ConfigurationManager I3 tab is located to the right of the

PropertyManager = tab. Use the ConfigurationManager to
create, select and view multiple configurations of parts and
assemblies.

The icons in the ConfigurationManager denote whether the
configuration was created manually or with a design table.

The DimXpertManager & tab provides the ability to insert
dimensions and tolerances manually or automatically. The
DimXpertManager provides the following selections: Auto

Dimension Scheme @, Auto Pair Tolerance, Basic,
Location Dimension ™, Basic Size Dimension
General Profile Tolerance 8 , Show Tolerance Status +@

Copy Scheme b , Import Scheme H} and TolAnalyst Study

SOLIDWORKS® 2019 Quick Start

@
WConfigu:a'tionManagerl
~ & @ FLATBAR-DesignTable Con

v [ETables

|  Default [ GIDS-sC-100(

| — 3HOLE [ GIDS-SC-1000
| = 5HOLE [ GIDS-SC-1000
| = 7HOLE [ GIDS-SC-1000

%\IH%\%O\ T

KI.

Fly-out FeatureManager

The fly-out FeatureManager design tree
provides the ability to view and select items in
the PropertyManager and the FeatureManager
design tree at the same time.

Throughout the book, you will select commands
and command options from the drop-down
menu, fly-out FeatureManager, Context toolbar,
or from a SOLIDWORKS toolbar.

w s

" Another method for accessing a command
is to use the accelerator key. Accelerator keys
are special key strokes, which activate the drop-
down menu options. Some commands in the
menu bar and items in the drop-down menus
have an underlined character.

@ oo B
D\
> @ FLATBAR DesignTa
I
B History
EE LPattern1 @ Sensors
v X » [0 Design Binder
_— ’ Annotations
Direction 1 AN , . i
Edge<1> Solid Bodies(1)
Equations
@ Spacing and instances 55 6061 Alloy
O Up to reference m Front Plane
<5 0.500in [fﬁ = Ej Top Plane
Di-z: 9 [‘rﬁ - Ej Right Plane
I-. Origin

Direction 2

Features and Faces

% Boss-Extrude

@ Cut-Extrude

»
~ ] ’ ut-Extrude

[Pattern

@

D Bodies

Instances to Skip
Options
Vary sketch
D Geometry pattern

Propagate visual
properties

Orull preview
@ Partial preview

A
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Task Pane

The Task Pane is displayed when a SOLIDWORKS session starts. You can show, hide,

and reorder tabs in the Task Pane. You can also set a tab as the default so it appears
when you open the Task Pane, pin or unpin to the default location.

The Task Pane contains the following default tabs:

e SOLIDWORKS Resources ﬁ.

3 [ ® 5 0 & >

e Design Library iy

e File Explorer 7 . % R
. . P o
e View Palette 8. @ G & 1
E esign Library
o Appearances, Scenes and Decals @ @ T Toolbox
= = v 3D ContentCentral
e Custom Properties &= = e enicent

> % Supplier Content

.
o SOLIDWORKS Forum ™, @ .« B UserLibrary
|S2| > [ SOLIDWORKS Content
3%
“¥" Additional tabs are displayed with Add-Ins. =

Use the Back and Forward buttons in the Design Library tab
and the Appearances, Scenes, and Decals tab of the Task Pane & SER
to navigate in folders.
£ Welcome to SOLIDWORKS

SOLIDWORKS Resources

SOLIDWORKS Tools &
@ Property Tab Builder

Jle

The basic SOLIDWORKS Resources & menu displays the
following default selections:

SOLIDWORKS Rx

Performance Benchmark Test

Compare My Score

o Welcome to SOLIDWORKS.

Bl

4% Copy Settings Wizard

e SOLIDWORKS Tools. % My Products

e  Online Resources Online Resources )
' @ 3DEXPERIENCE Marketplace

t Partner Solutions

e  Subscription Services.

Subscription Services R

Other user interfaces are available during the initial software
installation selection: Machine Design, Mold Design, Consumer
Products Design, etc.

@ Subscription Services
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Design Library

The Design Library W contains reusable parts, assemblies, and

other elements including library features.

The Design Library tab contains four default selections. Each

default selection contains additional sub categories.
The default selections are:

e Design Library.

e Toolbox.

o 3D ContentCentral (Internet access required).

e  SOLIDWORKS Content (Internet access
required).

AR Activate the SOLIDWORKS Toolbox. Click
Tools, Add-Ins.., from the Main menu. Check the
SOLIDWORKS Toolbox Library and
SOLIDWORKS Toolbox Utilities box from the
Add-ins dialog box or click SOLIDWORKS
Toolbox from the SOLIDWORKS Add-Ins tab.

To access the Design Library folders in a non-

network environment, click Add File Location il
and browse to the needed path. Paths may vary
depending on your SOLIDWORKS version and
window setup. In a network environment, contact
your IT department for system details.

File Explorer

File Explorer [ duplicates Windows Explorer from

your local computer and displays:
e  Recent Documents.

o Samples.

e  Open in SOLIDWORKS

e Desktop.
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«

Bt

"GO e T

> @ Design Library
? Toolbox
v @':'D ContentCentral
> % Supplier Content

> @ User Library
> EY SOLIDWORKS Content

Add-Ins

Active Add-ins

Last Load

Start Up Time

[=/SOLIDWORKS Premium Add-ins

g4

OGP CircuitWorks

&S Featureworks

0@ Photoview 360

0% ScanTo3D

@[, SOLIDWORKS Design Checker
0 @ SOLIDWORKS Motion

0 sOLIDWORKS Routing

T SOLIDWORKS Toolbox Library

w& SOLIDWORKS Simulation
SOLIDWORKS Toolbox Utilities
%] SOLIDWORKS Utilties

OE T Tolanalyst

(ZISOLIDWORKS Add-ins

0O0DO0DOoOOoao

0o oooo
A

0O 8 O @ O

a

Autotrace

SOLIDWORKS Composer
SOLIDWORKS Flow Simulation 2019
SOLIDWORKS Forum 2019
SOLIDWORKS PCB 2019

0D O & O
A

& E

Motion Routing

Simulation

% T

DLIDWORKS SOLIDWORKS SOLIDWORKS}IDWORKS T

oolbox

SOLIDWORKS Add-Ins |

A

>

Vv & Recent Documents

@ C:\Users\Daveph\Documents\WP,
@ C:\Users\Daveph\Documents\207
@ C:\Users\Davep\Documents\201
[B2 C:\Users\Davepl\Documents\20
[B8 C:\Users\Davepl\Documents\20°
@ C:\Users\Davepl\Documents\201
@@ C:\Users\Daveph\Documents\201
& C:\Users\Davepl\Documents\207
@ C:\Users\Davep\Documents\201
@ C:\Users\Davepl\Documents\201
@ C:\Users\Davep\Documents\201|
@ C:\Users\Davepl\Documents\201
@ C:\Users\Davepl\Documents\201
@ C:\Users\Davep\Desktop\Adrier
@ C:\Users\Davep\Desktop\Adrien
& C:\Users\Davep\Desktop\Adrien
Samples (C:\Users\Public\Documen

> & Open in SOLIDWORKS
> [ Desktop (desktop-pjirbmg)
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Search

The SOLIDWORKS Search box is displayed in the upper right
corner of the SOLIDWORKS Graphics window (Menu Bar
toolbar). Enter the text or key words to search.

New search modes have been added to SOLIDWORKS
Search as illustrated.

View Palette

The View Palette &2 tool located in the Task Pane provides
the ability to insert drawing views of an active document, or
click the Browse button to locate the desired document.

Click and drag the view from the View Palette into an
active drawing sheet to create a drawing view.

R

AR The selected model is FLATBAR-DesignTable in the
illustration.
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@ Search Commands QE&

Commands

MySolidWorks

Files and Models

A3

Blogs
CAD Models

Training

EBOZ8AE

l Youtube

u Twitter

Knowledge Base

Community Forum

RIRRIRIRIRIR] «

<«

s

Options

FLATBAR-DesignTable.S *
FLATBAR-DesignTable.SLDF

Import Annotations

|:| Design Annotations
DimXpert Annotations

[]Include items from hidden feature

|:| 3D View Annotations

Auto-start projected view

- lx

‘ Drag views onto drawing sheet.

(A) Front

*Right

*Left

RN

*lsometric

(A) Top

*Dimetric
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Appearances, Scenes, and Decals

Appearances, Scenes, and Decals @ provide a simplified
way to display models in a photo-realistic setting using a
library of Appearances, Scenes, and Decals.

An appearance defines the visual properties of a model,
including color and texture. Appearances do not affect
physical properties, which are defined by materials.

Scenes provide a visual backdrop behind a model. In
SOLIDWORKS they provide reflections on the model.
PhotoView 360 is an Add-in. Drag and drop a selected
appearance, scene or decal on a feature, surface, part or
assembly.

Custom Properties

The Custom Properties = tool provides the ability to enter
custom and configuration specific properties directly into
SOLIDWORKS files.

SOLIDWORKS Forum

Click the SOLIDWORKS Forum "2 icon to search directly
within the Task Pane. An internet connection is required.
You are required to register and to log in for postings and
discussions.

User Interface for Scaling High Resolution
Screens

The SOLIDWORKS software supports high-resolution, high-
pixel density displays. All aspects of the user interface respond
to the Microsoft Windows® display scaling setting. In dialog
boxes, PropertyManagers, and the FeatureManager design tree,
the SOLIDWORKS software uses your display scaling setting

to display buttons and icons at an appropriate size. Icons that are

associated with text are scaled to a size appropriate for the text.
In addition, for toolbars, you can display Small, Medium, or
Large buttons. Click the Options drop-down arrow from the
Standard Menu bar, and click Button size to size the icons.
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Kppearances, Scenes, ar{@}.—ﬂ

v

> e Appearances(color)

> ﬁ Scenes

> Decals

Jep

\

tﬂ‘m

<< Custom Properties {é} o
Apply Reset

A property page for part files
was not found. Click 'Create
now..." to launch the Property
Tab Builder.

Jak

If you already have a template,
place it in the folder specified
in Tools — Options — File
Locations — Custom Property
Files.

Rl

Press F5 to refresh the page.

Create now...

FLATBAR-DesignTablg

=

é@}' Options
Customize...
Add-Ins...
Save/Restore Settings...

Button Size
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Motion Study tab

Motion Studies are graphical simulations of motion for an assembly. Access the
MotionManager from the Motion Study tab. The Motion Study tab is located in the bottom
left corner of the Graphics window.

H]

12 sec
N

Basic Motion V‘ﬁl» > '—"%‘ﬁ‘ ‘@%\K (% v
0 sec 1 sec 2 sec 3 sec |4 sec 5 sec 6 sec 7 sec 8 sec 9 sec 10 sec 11 sec

Eﬁ}ﬁ%%, ‘\H\\HH‘HH\HH‘H\\\HH‘HH\HH‘HH\HHHH\HH|\H\\HH‘IHW\H‘HHM\H‘\H\\HH‘HH\HH‘HHWH

QN ~ @MotionSt

@Orieni

4 Lights

—Q Linear|

3|

13 seq

o Gravit|
v » |8 ) tah

<
- Model | 3D Views | Motior Study 1 |

L a & = o o 2

Incorporate visual properties such as lighting and camera
perspective. Click the Motion Study tab to view the
MotionManager. Click the Model tab to return to the
FeatureManager design tree.

The MotionManager displays a timeline-based interface and
provides the following selections from the drop-down menu as
illustrated:

o Animation: Apply Animation to animate the motion of an
assembly. Add a motor and insert positions of assembly
components at various times using set key points. Use the
Animation option to create animations for motion that do not
require accounting for mass or gravity.

e Basic Motion: Apply Basic Motion for approximating the
effects o.f mOtors, Springs, collisions apd gravity on ~N S
assemblies. Basic Motion takes mass into account in 2 oo g cop—

Screen Capture

calculating motion. Basic Motion computation is relatively

Modify

fast, so you can use this for creating presentation animations ~ o
using physics-based simulations. Use the Basic Motion . roies

Workspace

option to create simulations of motion that account for mass, § Tt

.« . . . Full Screen
collisions or gravity.

50 201030

¥ If the Motion Study tab is not displayed in the Graphics
window, click View > Toolbars > MotionManager from the

Menu bar.
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3D Views tab Capture 3D View
SOLIDWORKS MBD (Model Based Definition) lets you ooy
create models without the need for drawings giving you an Update Previws
integrated manufacturing solution. MBD helps companies mEe

define, organize, and publish 3D product and manufacturing
information (PMI), including 3D model data in industry
standard file formats.

Create 3D drawing views of your parts and assemblies that IS viodel | 3D Views | Motion Study 1
contain the model settings needed for review and Vo Ada
manufacturing. This lets users navigate back to those settings as | 4e¥ ] Features
they evaluate the design. e
Use the tools in the SOLIDWORKS MBD CommandManager Surfaces

. . . . Sheet Metal
to set up your model with selected configurations, including Weldments
explodes and abbreviated views, annotations, display states, Mold Tools
zoom level, view orientation and section views. Capture those Mesh Modeling
settings so that you and other users can return to them at any E_""a t“";:_’:“"”
time using the 3D view palette. % e
To access the 3D View palette, click the 3D Views tab at the e
bottom of the SOLIDWORKS window or the SOLIDWORKS T
MBD tab in the CommandManager. The Capture 3D View MBD
button opens the Capture 3D View PropertyManager, where i‘;\t‘vz‘;"or‘“ M
you specify the 3D Vi§W name, and the configuration, display SOLDWORKS CAM TBM (vil
state and annotation view to capture. See SOLIDWORKS help SOLIDWORKS CAM TBM (Turn)
for additional information. Arualyes Prepe e

Use Large Buttons with Text
Customize CommandManager...

Dynamic Reference Visualization

(Parent/Child) & ER ¢ @
Dynamic Reference Visualization provides the ability to g 2 FLATEAR DesignTable (Dt
view the parent/child relationships between items in the History
FeatureManager design tree. When you hover over a Sensors

feature with references in the FeatureManager design » [T Design Binder

tree, arrows display showing the relationships. If a » [&] Annotations
reference cannot be shown because a feature is not » [@]Solid Bodies(1)
expanded, the arrow points to the feature that contains Equations

O —
3% 6061 Alloy
E] Front Plane

E] Top Plane
E] Right Plane

I_, Origin
Rt ]
4 Cut-Extrude1 <+—Sketch2

BE LPattern1

the reference and the actual reference appears in a text
box to the right of the arrow.
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Use Dynamic reference visualization for a Vieygnsert Tools Window Help # | Y [)-F-&-&-") [0 B
part, assembly and ever mates. B2 vy it

Screen Capture
To display the Dynamic Reference Display
Visualization, click View » User Interface [Ag;fyd -
» Dynamic Reference Visualization

Parent/Child) from the Main menu bar.

Hide / Show

Toolbars 0 g
Workspace >

User In e
Mouse Movements B

& Touch
:D: Full Screen F11

> | ¥ | FeatureManager Tree Area

29| Dynamic Reference Visualization (Parent)
A mouse typically has two buttons: a primary g Dyramic Reference Visulztion (Cil)
button (usually the left button) and a

secondary button (usually the right button).
Most mice also include a scroll wheel
between the buttons to help you scroll through
documents and to Zoom in, Zoom out

and rotate models in SOLIDWORKS. It @
is highly recommended that you use a . [ J
mouse with at least a Primary, Scroll . Jﬁ’ﬁ y

and Secondary button. S L\t B

Customize Menu

¥ | Task Pane
¥ | MotionManager

v | Status Bar

Single-click A

To click an item, pOil’lt to the item on (1) Primary button (2) scroll wheel {3) Secondary button
the screen, and then press and release

the primary button (usually the left button). Clicking is most often used to select (mark) an
item or open a menu. This is sometimes called single-clicking or left-clicking.

Double-click

To double-click an item, point to the item on the screen, and then click twice quickly. If the
two clicks are spaced too far apart, they might be interpreted as two individual clicks rather
than as one double-click. Double-clicking is most often used to open items on your desktop.
For example, you can start a program or open a folder by double-clicking its icon on the
desktop.

Right-click

To right-click an item, point to the item on the screen, and then press and release the
secondary button (usually the right button). Right-clicking an item usually displays a list of
things you can do with the item. Right-click in the open Graphics window or on a command in
SOLIDWORKS, and additional pop-up context is displayed.

Scroll wheel

Use the scroll wheel to zoom-in or to zoom-out of the Graphics window in SOLIDWORKS.
To zoom-in, roll the wheel backward (toward you). To zoom-out, roll the wheel forward
(away from you).
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Summary

The SOLIDWORKS (Ul) is designed to make maximum use of the Graphics window for
your model. Displayed toolbars and commands are kept to a minimum.

The SOLIDWORKS User Interface and CommandManager consist of the following main
options: Menu bar toolbar, Menu bar menu, Drop-down menus, Context toolbars,
Consolidated fly-out menus, System feedback icons, Confirmation Corner and Heads-up
View toolbar.

The default CommandManager Part tabs control the display of the Features, Sketch,
Evaluate, DimXpert and SOLIDWORKS Add-Ins toolbars.

The FeatureManager consists of five default tabs:

e FeatureManager design tree.

e PropertyManager.

e (ConfigurationManager.

e DimXpertManager.

e DisplayManager.

You learned about creating a new SOLIDWORKS part and opening an existing
SOLIDWORKS part along with using the Rollback bar to view the sketches and features.

Opening a SOLIDWORKS document from an earlier release can take extra time. After
you open and save a file, subsequent opening time returns to normal. Use the
SOLIDWORKS Task Scheduler (SOLIDWORKS Professional) to convert multiple files
from an earlier version to the SOLIDWORKS 2019 format. Click Windows Start > All
Apps » SOLIDWORKS 2019 » SOLIDWORKS Tools 2019 > SOLIDWORKS Task
Scheduler.

R

3 Overall drafting standard

N If you modify a document property from an Overall drafting ‘ ANSI-MODIFIED

standard, a modify message is displayed as illustrated.
Derived from: ANSI
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Templates are part, drawing and assembly documents which include user-defined
parameters. Open a new part, drawing or assembly. Select a template for the new

document.

e Parts. The Parts default template is located in the

C:\ProgramData\SolidWorks\SOLIDWORKS 2019\templates\Part.prtdot folder.

e Assemblies. The Assemblies default template is located in the

C:\ProgramData\SolidWorks\SOLIDWORKS 2019\templates\Assembly.asmdot

folder.

e Drawings. The Drawings default template is located in the

C:\ProgramData\SolidWorks\SOLIDWORKS 2019\templates\Drawing.drwdot

folder.

For commercial users, SOLIDWORKS Model Based Definition (MBD) is a separate
application. For education users, SOLIDWORKS MBD is included in the

SOLIDWORKS Education Edition as an Add In.

N If you modify a document property from an Overall drafting
standard, a modify message is displayed as illustrated.

In Chapter 2, establish a SOLIDWORKS session. Learn about 2D
Sketching and 3D features.

Create a new part. Create the Wheel for the Fly Wheel sub-
assembly. Utilize the Fly Wheel sub-assembly in the final Stirling
Engine assembly.

Apply the following sketch and feature tools: Circle, Line
Centerline, Centerpoint Straight Slot, Mirror Entities, Extruded
Boss, Extruded Cut, Revolved Boss, Circular Pattern, Hole Wizard
and Fillet.

PAGE 1-37

Overall drafting standard
| ANSI-MODIFIED

Derived from: ANSI




Overview of SOLIDWORKS® and the User Interface SOLIDWORKS® 2019 Quick Start

Incorporate design change into a part
using proper design intent, along with
applying multiple geometric relations:
Coincident, Vertical, Horizontal,
Tangent and Midpoint and feature and
sketch modifications.

Utilize the Material, Mass Properties
and Appearance tool on the Wheel.

“¥" Times in academic integrity cases.
Right-click on a sketch or feature.
Select properties from the Pop-up
menu. View who created the sketches
and features in a SOLIDWORKS
model, and when (date + time).
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